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Introduction to LATEX

The files used in this section are first.tex, first.pdf, RJournal.zip,
Biometrics.zip, and nuthesis.zip.

Word
Word is a word processor. It is based on the “what you see is what
you get” (WYSIWYG) philosophy of typing documents. The soft-
ware allows one to see immediately what the document is going
to look like printed after it is typed.
I really like Word. Through typing a 300+ page dissertation in

Word, lecture notes for most courses, and many published journal
articles, I have learned how to use Word very well. However, there
are issues with the software:
• Current Word equation editor: It simply is not good enough
for complex equations. MathType serves as very nice replace-
ment, but there are some issues with its use (to be discussed
shortly).

• Floating tables and figures: While you can do these (anchor a
table or figure to a page), I often have problems getting text
to flow around it.

• Euclid font: MathType’s Euclid font allows for a Word docu-
ment to look similar to that of the default Computer Modern
font of LATEX. However, Greek letters and symbols often look
a little different in and outside of equations.

• In-line equations: You need to manually break equations at
the end of a line. This is especially needed with full justifica-
tion of text.

• Equation sizing: MathType equations are embedded images.
The sizes of these images change over many saves of a Word
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document (since Word 2007).
• 64-bit capability:There has been issues with 64-bit Word com-
patibility of MathType (I have not checked this with the
newest version of MathType).

• PowerPoint: If you use MathType, inline equations are not
possible. Instead, you need to create separate images that
need to be lined up within the normal text.

TEX
TEX is a programming language used for typesetting. The lan-
guage was developed in the 1970s to help improve the typographi-
cal quality of documents. I do not think anyone uses TEX directly
anymore. Instead, people use . . .

LATEX
LATEX is TEX with additional add-ons to make typesetting much
easier to use than TEX alone.
Why use LATEX?
• It’s free!
• The majority of statistical (and math, computer science, many
other science disciplines) researchers use it.

• Much of the decision process for how your paper will look
(e.g., fonts, section titles, bibliography style) is no longer the
author’s responsibility. There are set styles available to control
all formatting. This is kind of like “Styles” available in Word,
but to a much larger degree.

• Simply, documents will look nicer with LATEX than Word.
HOWEVER, one can often develop close approximations
within Word by using the Euclid font and MathType.
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• Some journals require (or strongly encourage) the use of LATEX.
Journals will provide a particular type of “style” file that can
be used to ensure the paper is within the journal’s own style.
This allows these journals to more quickly get an accepted
paper into the official journal version.

• Book publishers often encourage authors to type their book in
LATEX for similar reasons as journals.

• Before a journal or book is published, proofs of the final form
will be sent to an author. If the submitted version was in
LATEX, there will be a much smaller number of errors to correct
by the author than if Word was used (non-LATEX documents
often need to be re-typed by the publisher).

LATEX is not a word processor. Rather, it allows one to type a
document using a programming language sort of like HTML. A
LATEX document then needs to be compiled so that a PDF (or
other file type) can be created.
Still, I do not like LATEX. So, why are we discussing it here?

In order to use LYX! LYX uses LATEX to create its documents
through a nice Word-like GUI. Still, it will be helpful to know
about LATEX when using LYX, especially when one needs to in-
clude a little LATEX code in a LYX document. Plus, it can be
difficult sometimes to get a journal’s LATEX template (.sty or .cls
files) to work completely with LYX. This leads one to use LYX for
most of the composing of a paper and then export it as a LATEX
document toward the end of writing.

MikTEX
Most people do not use LATEX directly. Instead, they use other
implementations of LATEX and TEX. The most popular one for
Windows is MiKTEX, and this is what my collaborators and I
use. While people may use MiKTEX, most people will still say
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they use LATEX. Note that MikTEX is free.
MikTEX’s website is at http://miktex.org. Select the Down-

load link to download it to your computer. Note that installation
can take some time. Alternatively, you can have MikTEX in-
stalled during a LYX installation (select the bundle executable at
http://www.lyx.org/Download)

CTAN
Similar to R, there are many user created packages that users can
download and install. The Comprehensive TEX Archive Network
(CTAN) is LATEX’s version of CRAN. Its website is http://www.
ctan.org. Note that UNL has a mirror at http://mirror.unl.
edu/ctan.

Program editors
The typical process for using LATEX is to type LATEX code into
a program editor. This code needs to be manually compiled in
order to create a PDF of what a document will look like (i.e., like
what you would see in Word). Editors will have a button for you
to click on to complete the compilation.
Below are descriptions of a few program editors. There are

many other editors available!

TEXworks
This editor comes with MikTEX. The website for it is http:
//www.tug.org/texworks. The editor is functional, but I think
there are better editors available.
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WinEdt
I have used this editor since 2004. The editor is shareware. After
a 31 day free trial, you can purchase it or deal with annoying
messages about purchasing it. WinEdt can be downloaded from
http://www.winedt.com.
Below is a screen capture fromWinEdt 10 with the First.tex file

(example to be discussed shortly) displayed within it. This editor
has the nicest syntax highlighting of all editors that I have seen,
and it allows for code folding (see the plus signs in the margin
next to the code).
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Texmaker
This editor is free, and it can be downloaded from http://www.
xm1math.net/texmaker. I have used it since 2012 as a nice,
free alternative to Winedt. Below is a screen capture from ver-
sion 4.5 with First.tex displayed within it. Code folding can be
done within the editor although it is not as conveniently available
as in WinEdt.1 Linked side-by-side views of the .tex and PDF
documents are available, although there is no instantaneously up-
dating for the PDF when code changes. The PDF can be popped
out of the right side by clicking on the red button in the upper
right side for the viewer. If you do not want to see the PDF
viewer, select View > Pdf Viewer or turn it off by selecting
Pdf Viewer in the left bottom corner. I usually leave the PDF
viewer off.

1The cursor must be positioned in the first line of a block of text that can be folded (e.g., a \section{}). This will bring up an
orange minus sign (-) and a vertical line next to the line numbers. Click on the minus to fold the text.
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TEXstudio
This editor is free, and it can be downloaded from http://
texstudio.sourceforge.net. I have used it a little since 2014.
This editor’s syntax highlighting is more customizable than in
Texmaker’s editor, making TEXstudio perhaps a stronger com-
petitor to WinEdt. For example, one can change the background
color of particular types of code with Options > Configure
TEXstudio > Syntax Highlighting. Below is a screen cap-
ture from version 2.10.8 with First.tex displayed within it.
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Other editors
• Gummi (free): The editor is similar to the previous edi-
tors, but it provides an instant preview of what the PDF
will look like. It is still being developed, but perhaps with-
out as much activity as needed. See https://github.com/
alexandervdm/gummi.

• ShareLATEX (not free): An online LATEX editor; https://www.
sharelatex.com

• Winshell (free): This is a free editor similar to Texmaker;
http://www.winshell.org
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Hello World!
Examine the First.pdf document to see what first.tex will create
after being compiled:

LATEX files (.tex extension) begin with a preamble that describes
what the document will look like. The preamble contains:
• Document class – article, book, letter, . . . , and various op-
tions like the font type and size

• Packages – Particular packages from which to obtain special-
ized commands
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• Margins, spacing, and other items
Below is the preamble for the example LATEX document:

Comments:
• LATEX is case sensitive.
• The document class chosen here is article, which would be
appropriate for a number of situations including a paper sub-
mitted to a journal.

• The percent symbol % is used to begin comments.
• The hyperref package allows one to create clickable cross-
references within a document. The bookmark options create
bookmarks for the PDF document based on section titles.

• Note that MikTEX comes with a number of packages. Pack-
ages that are not on a computer already will be downloaded
provided the correct package installation settings are selected.
You can check these by opening the “Settings (Admin)” appli-
cation for MikTEX:
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Select Yes for Install missing packages on-the-fly
in the General tab.
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• An example user defined function is given at the end of the
preamble. How this is used will be discussed later.

The remainder of a document is the document’s body. It is simply
enclosed within

\begin{document}
\end{document}

Below is the document’s body (shown in WinEdt):
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Comments:
• \section{} and \subsection{} create the sections for the
document. These specific commands are available because ar-
ticle was chosen as the document class.

• Potential misspellings are highlighted in the text by the editor.
There is no grammar check.

• Mathematical symbols and equations are enclosed within dol-
lar signs. A single dollar sign $ is used for an inline sym-
bol/equation and double dollar signs $$ are used for a dis-
played symbol/equation that is on a line of its own. It can
take some time to know the correct words for symbols! Below
are some basics:
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– Spell out Greek letter names
– Underscore _ creates subscripts
– Carat ^ creates superscripts
There are a number of sources available on the Internet where
symbols are listed–see the link to Marie Davidian’s notes later.

• The dollar signs are a shortcut way to begin a math envi-
ronment within LATEX. Environments allow one to let LATEX
know that a specific type of text is used. The general syntax
for inline mathematical symbol/equation is

\begin{math}
<Insert equation code here>
\end{math}

An additional environment example is given for a list us-
ing the enumerate environment. Note that \section{} and
\subsection{} are actually starting environments too, but
shorthand syntax can again be used with them too by leaving
off the \begin{} and \end{}.

• A cross-reference is created using \label{}, and it is refer-
enced with \ref{}.

• Tables are not very user friendly to create within LATEX. The
example in the document shows the code for a very simple
2× 3 table where the third column purposely has no content.

• \ybar is an example of a user-defined shortcut expression to
specify a longer set of code.

• Extra spaces between words are ignored!!!
• Blank lines between text are ignored!!!

In order to create the PDF shown at the beginning of this exam-
ple, the LATEX code needs to be compiled. This is done by clicking
on the correct icon in an editor:
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• WinEdt

Make sure PDFLATEX is selected in the dropdown menu and
select the PDF L icon.

• Texmaker

Make sure PDFLATEX is selected in the dropdown menu and
select the arrow to the left of it. The default of Quick Build
uses PDFLATEX too and also puts the PDF in the right side
viewer (see Options > Configure Texmaker > Quick
Build).

• TEXStudio

Before compiling, you will need to close any previous PDF file for
the document (outside of PDF viewers) before a new PDF can be
created.
Other files will be created in addition to the PDF (most are

plain text documents). These files include:
• .log – This is a typical log file created by a compiler. Error
and warning messages will be put there.

• .aux – An auxiliary file that stores information needed from
one compilation run to the next.
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• .out – Additional information saved from one compilation run
to the next.

More complicated LATEX documents will lead to additional files.
See page 14 of Oetiker et al. (2011) for descriptions. These files
generally should not be deleted, but they do not need to be shared
with others.
What happens if a different document class is used? It depends

on the class. Code like \section and \subsection are associated
with the article document class. They may not be used with
other classes. With the current example, you can try the book
document class to see one that works. With this document class,
one can now use \chapter (no chapter is defined in my document
so section numbers will start with a “0” in the PDF).

Resources for LATEX
• Marie Davidian’s lecture notes for NC State’s STAT 810A’s
“Preparation for Statistical Research Course” at http://
www4.stat.ncsu.edu/~davidian/st810a/index.html. See
the introduction to LATEX on 1/25/05 and 2/1/05.

• Oetiker, T., Partl, H., Hyna, I. and Schlegl, E. (2011). The
Not So Short Introduction to LATEX 2e. Available at http:
//www.ctan.org/tex-archive/info/lshort/english.

• Comparison of LATEX editors: http://en.wikipedia.org/
wiki/Comparison_of_TeX_editors

• StackExchange for LATEX: http://tex.stackexchange.com
• LATEX basics at wikibooks: http://en.wikibooks.org/
wiki/LaTeX/Basics

• Rob Hyndman’s workshop: http://robjhyndman.com/
hyndsight/latex-workshop
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• The tikZ package allows one to draw figures with LaTex code.
See http://www.texample.net/tikz/examples.

• MathType can create LATEX code. For example, open the
MathType editor and simply select the Greek letter α in
the appropriate drop down menu. Select Preferences >
Translators > Translation to other languages
(text). Make sure the LATEX translator is chosen. Also,
uncheck the Include MathType data in translation
box. If you copy the letter in MathType and paste into Word,
you obtain:

$\alpha$

You can even write LATEX equation code in MathType (and
Word’s equation editor) to produce mathematical expressions.
Select Preferences > Workspace preferences and
check the Allow TEX language entry from the key-
board. In the editor, you can type \alpha and <ENTER>
to obtain α. Note that the first time you try this, MathType
may produce a warning message which then can cause prob-
lems during your first attempt.

Journal specific LATEX files
Most statistical research journals provide their own set of LATEX
instructions for submissions. These instructions may include ex-
ample LATEX files, style files (.sty), document class files (.cls), and
bibliography style files (.bst). The style and class files are used via
the \usepackage and the \documentclass commands, respec-
tively, and these commands are put in the preamble of a LATEX
file. It is easiest to put any of these files in the same folder as
your main .tex document so that LATEX can find them. We will
discuss .bst files when using LYX. Next are two examples of how
I have used LATEX when writing papers for journals.
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R Journal paper
This paper is the final version of Bilder et al. (2010, p. 56-
60) that was sent to The R Journal. Author instructions
for The R Journal are at http://journal.r-project.org/
submissions.html. Below is a screen capture from their web
page:

The R Journal provides a .sty file and .tex file examples. Au-
thors are expected to complete their own .tex file for the main
content of the paper and call this file within the RJwrapper.tex
file (similar to using %include in SAS or source() in R). The
RJwrapper.tex file is to be compiled. Note that The R Journal
changed its .sty file in 2013. I decided to use the original file
because this was used for publication.
Page 2 of the “Instructions for Authors” file provides informa-

tion on what the style file allows:
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For example, \code{} can be used to use a courier-like font for
simple in-line code. The example environment can be used for
long code examples that are offset from a paragraph.
Important items to notice in my own RJwrapper.tex file:
• The report document class is used where the size of the paper
is a4paper (commonly used European size).

• The RJournal.sty file is read in using \usepackage.
• A separate \usepackage is used to obtain the natbib bibliog-
raphy style (http://www.ctan.org/tex-archive/macros/
latex/contrib/natbib).

• The \input{} command instructs LATEX to include the con-
tents of BilderZhangSchaarschmidtTebbs.tex.

Important items to notice in BilderZhangSchaarschmidt-
Tebbs.tex:
• There is no preamble because this file is read in by RJwrap-
per.tex.
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• \citep{} and \citet{} are used to cite items in the bibli-
ography located at the end of the document. The \citep{}
gives parenthetical citations such as “(Bilder et al. 2010)”.
The \citet{} gives references in the form of “Bilder et al.
2010”. Each item in the bibliography has a user-defined name
associated with it which is cross-referenced within the {}.

• \begin{thebibliography} begins a simple bibliography en-
vironment. Each new entry begins with \bibitem[]{} where
the user-defined name is within {}. The code right after
\begin{thebibliography}{1} gives more format informa-
tion for what each bibliographic entry should look like.

• The \begin{example} and \end{example} code environ-
ment allows for long R code examples in a courier-like font.

Biometrics paper
This paper is the final version of McMahan, Tebbs, and
Bilder (2012, p. 793-804) that was sent to Biomet-
rics. Author instructions for submitting a paper to
Biometrics are provided at http://www.biometrics.tibs.
org/informationforauthors.html. Specific instructions
for LATEX are given at http://www.biometrics.tibs.org/
latexdocumentclass.htm, where a document class file named
biom.cls is given. Additional .tex example files are also
given. While authors are not required to use LATEX, it is now
STRONGLY preferred.
Important items to notice in MS110604P.tex:
• The document class is biom to correspond to biom.cls. The
referee option in \documentclass[]{} leads to a PDF file
that is easier for referees to examine. When this option is
removed, the PDF produced is in the form you see in the
actual journal. Note that figure and table placement will not
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look correct here.
• Most of the comments in the preamble are those given by

Biometrics in their biomsample.tex file.
• The eqnarray environment is used for mathematical equations
sometimes. This allows for mathematical expressions to line
up over multiple rows (think of a 3 column matrix where the
equal sign is in column 2).

• The figure environment is used to read in PDF files containing
plots. There is also a figure where LATEX code is used to create
a plot.

• The tabular environment is used for tables.
• Note that the figures and tables are given in the .tex file at
their approximate locations where the author would like them.
However, these items appear at the end of the PDF version of
the document. This location change is brought about by the
referee document class option.

• The asterisk in \section*{} is used to denote a non-
numbered section.

• References for this paper are manually typed in rather than
cross-referenced. They could be cross-referenced in a similar
manner as in the previous paper if desired.

Non-journal paper examples
Next are additional examples that do not necessarily correspond
to writing a paper for a journal.

UNL thesis
I found this .zip file at http://www.math.unl.edu/graduate
under “For Current Students” and “Resources”. After unzipping
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the file, the test folder gives an example template. Note that you
need to have the nuthesis.cls and unl.pdf files (located in the main
folder) in the test folder so that the example compiles correctly.
There is also a LYX file template located at the same website.

R and LATEX
There are a few R packages that create LATEX code to help
include output directly into a LATEX document. You can
go to a list of all R packages at http://cran.r-project.
org/web/packages/available_packages_by_name.html and
search for “latex” to see these packages. The Reproducible Re-
search task view at CRAN (http://cran.r-project.org/web/
views/ReproducibleResearch.html) also provides information
on R packages. We will make use of some of these packages during
the LYX and knitr discussion later in the semester.


